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PREFACE 

Today's society is marked by a sudden growth and development of the 

information technology (IT), which resulted in a great dependence of the 

society, in a broader sense, on the knowledge and competence of the 

person working in the IT area. And, despite the constant growth of the 

forementioned dependence, human right to education and information is 

not extended to the IT area. There is a presence of the problems which 

affect the society in whole, and create obstacles and distance people from 

the main reason and motivation for progress, the opportunity. Nowadays, 

to be a computer illiterate person means to be a person who is unable to 

participate in modern society, to be a person without an opportunity. 

Despite the fact that the European Commission, UNESCO, OECD and other 

relevant institutions have ackwnoledged the necessity and usefulness of 

the computer literacy, there are still griups of people with difficult access 

to the basic computer education (such as people with disabilities, people 

with learning difficulties, migrant workers, unemployed people, people 

who live in remote places without an access to the computer education). 

This handbook, along with all other materials published on the ITdesk.info 

web page, represent our contribution to realization and promotion of the 

human right to education and information in the IT area. We hope that this 

education will help you in overcoming the basic computer skills and with 

that hope, we wish you to learn as much as possible and therefore become 

the active member of the modern IT society.  

Sincerely yours, 

ITdesk.info team 

 

Expert review of Croatian version: 
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1 OPERATING SYSTEM - OS 

1.1 BASIC OPERATIONS 

Turning on the computer  

 To turn on the computer, press the  button, located on the computer case 

 Enter the Username and a Password. At the first startup of the Linux Lite 1.0.2 
operating system, you will have to enter the username root and press the Enter 
button for the password. The user root has all of the administrative privileges and 
can make the changes to the operating system, upgrade, etc. 

After performing those actions, Computer Desktop will open. Located on the desktop are the 
following: 

 the list of available hard disks and connected USB sticks,  

 Help & Support function, and 

 Panel. 

 

Pic. 1 – Computer desktop 
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Panel 

Panel is a toolbar. Tools can be deleted from the panel and added to the panel. 

 

Pic. 2 - Panel 

Located on the Panel are: 

 Menu buttons  - for accessing the main menu with commands, 

 Firefox Web Browser  button  - for accesing the web browser, 

 Home Folder button  - a window for file and folder managing and displaying the 

original files of the User 

 Terminal button  - for entering the commands using the keyboard, 

 thumbnails of the currently open windows on the Workspace, 

 display of the Workspaces , 

 Master  speaker button – for opening the vertical scroll bar for adjusting the volume 

of the speakers, 

 Connected to button  - for opening the Wired Network Manager dialog box, 

containing the network properties and settings,  

  button- for displaying of the drop-down menu with the calendar and 

adjusting the current time and/or date. Drop-down menu is closed by pressing the 

 button again. 

Add a new icon to the Panel by: 

 pressing and holding the left mouse button on the icon that you wish to copy,  

 positioning it on the desired location on the panel (on the left or right side) and  

 releasing the left mouse button. 

Remove an icon from the Panel by: 

 pressing the right mouse button on the icon that you wish to remove, 

 choose the command Remove from the quick menu and 

 in the Are you sure that you want to remove ''Launcher'' dialog box, confirm the 

command by clicking on the buttonRemove. 
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Panel dimensions can be adjusted if you choose the command Settings  from the Menu  and 

then, from the newly opened menu, choose the command Panel. A dialog box Panel, in 

whose tab:  

 Display you can choose: 

o panel orientation - Vertical or Horizontal and  

o panel dimensions – Icon Size  and Panel Length 

 Appearance, used for editing the background color of the panel 

 Items, used for adding and removing items from panel (i.e. Date and Time, Web 

browser etc.) or changing the item order on the panel, by using the button on the right 

side of the dialog box 

 

Pic. 3 –Panel dialog box 

  



ITdesk.info – project of computer e-education with open access 

ITdesk.info is licensed under a Creative Commons Attribution-  

Noncommercial-No Derivative Works 3.0 Croatia License   4/57 

Menu 

Menu is the starting point of the system. Via Menu, you can access programs, configure 

computer settings, access Help & Support function, sign out, restart or shutdown the 

computer… 

 

Pic. 4 –  Menu 

To add commands to Menu, you need to choose the command  Settings from the Menu and, 

from a newly open menu, choose the command Main Menu. A dialog box Main Menu will 

open, in which you choose and add the desired commands. On the left side of the dialog box, 

there is a list of all Menus, and in the middle of the dialog box, there is a list of all available 

Items for the chosen menu, while on the right side of the dialog box, there are buttons that 

allow you to:   

 Add New Menu,  or 

 Add New Item to the existing menu, or 

 Insert New Separator  for the items, or  

 Set the order of items display using the Move Up and Move Down buttons, or 

 Edit Properties and  

 Delete items and Close. 

To display inactive commands, you need to: 

 find the inactive command in the Items and  

 click on the empty checkbox next to the icon in the Show column using the left mouse 

button and  

 confirm the activation of the command by clicking on the button  
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To hide a command, you need to remove the check from the checkbox placed next to the 

command name in the Show column. 

 

Pic. 5 – Main Menu 

 

Dialog box is closed by clicking on the Close button, and actions are cancelled using 

the Revert  button, which restores the default settings.  
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The correct way to shutdown and restart the computer  

The computer is shutdown and restarted via the Menu. From the Menu, choose the Log Out 
command. This will open a Log out user dialog box. By selecting the command  

 Log Out, the user logs out 

 Restart, the computer turns off and then on again 

 Shut Down, the computer turns off 

 Suspend, all of the processes are stopped and getting ready for the next restarting of 
the computer, while the computer is being shutdown. 

 

Pic. 6 - Log out user dialog box 

Shutting down the computer and non-responding applications  

Shutting down the computer 

Reset button is located on the computer case and is used if the computer doesn’t respond  to 
the given commands (if it “freezes”). It is usually below the power button. After the button is 
pressed, the computer restarts.  

If there is no Reset button on the computer case, press and hold the  button on thhe 
computer case for a few seconds. After you release the button, the computer shuts down. 

Shutting down the non-responding application (“frozen”, not responding)  

If the application freezes and stops reacting, you can solve that problem, in most cases by 

opening command Task Manager. 

Choose the Accessories command from the Menu, and from the newly opened menu, choose 
the Task Manager command. Task Manager dialog box will open, in which you need to find 
the “frozen” application. By right clicking on the “frozen” application, a dialog box will open 
that will help you to:  

 Stop – the process is momentarily stopped, and can be continued later on, 

 Kill– the process is momentarily stopped 
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 Terminate – the process is gradually being stopped or 

 Change Priority – other processes are given a bigger/smaller advantage. 

 

Pic. 7 –Task Manager dialog box 

Task Manager dialog box is closed by clicking on the Quit  icon. 

 

Using Help & Support function  

Help & Support function is launched by double-clicking on the Help & Support   icon, 
located on the Desktop. This will open the Linux Lite Help & Support window, in whose search 
box you first enter, then search terms. By pressing the F1 button in the active window of a 
program, (i.e. LibreOffice Writer), Help function, which is connected directly to that program, 
will appear. 

Other way of launching Help & Support function is via theMenu. 

For a computer that is connected to a network, Help & Support function searches the terms 
via Google. If the computer is not connected to a network, you can only search terms  which 
are shown in the Linux Lite Help & Support window tab. 
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Pic. 8 Help & Support dialog box 

Help & Support function can provide answers to the basic questions regarding the operating 
system. The users of Linux based operating system are advised to use the forums designed for 
Linux users. For starters, it is recommended to visit a forum in Croatian: 
http://www.forum.hr/forumdisplay.php?f=92 

 

Pic. 9 – Forum in Croatian 

or forum in English: http://www.linuxforums.org/forum/forum.php.  

http://www.forum.hr/forumdisplay.php?f=92
http://www.linuxforums.org/forum/forum.php
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1.2 BASIC SYSTEM INFORMATIONS AND OPERATING SYSTEM SETTINGS 

System informations  

You can open a dialog box containing system operations by choosing the command System 

from the Menu, and then from the newly opened box, choose the command System 

Information. A System Information dialog box will open, which contains the informations 

about the operating system that is installed on the computer and all the basic informations 

about the computer.  (CPU type, installed memory etc.). 

Choosing one of the items from the left pane: Computer, built-in Devices, Network or 

Benchmarks, will show detailed informations on the chosen item in the right pane.  

 

Pic. 10 - System Information dialog box 

System Information can be copied to the Clipboard and later Pasted to, for example, a word 

processing tool, LibreOffice Writer, or a report can be made using the Generate Report 

command, containing all the system informations. 
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Workspaces  

Workspaces are, actually, virtual Desktops. Thumbnails of Workspaces are located on the 

right side of the Panel. Inside every workspace, there is a thumbnail and the position of all of 

the currently opened windows. Active Workspace has a blue background, and an inactive one 

has a gray background. Workspace is activated by left-clicking the mouse on the  workspace 

thumbnail. 

If you right-click the workspace thumbnail, it will open a dialog box containing the basic 

technical data about the workspace – type of the used workspace (i.e. xfce, gnome, kde, etc.), 

credits, licence etc.  

 

Pic. 11 – Dialog box containing data about the workspace 

If you press and hold the right mouse button over the workspace, the drop-down menu will 

appear with the following functions: 

 Properties – for adjusting the workspace properties and switching to another 

workspace 

 Move – for moving the workspace 

 Workspace Settings – opens a dialog box Workspaces in which you can set the 

number of working spaces and margins of the workspace 

 Remove – for removing a Workspace  

 Panel – for   commands such as Add New Items, Log Out and setting the panel 

properties.   

Releasing the right mouse button over the wanted option will open a dialog box with the 

characteristics of the chosen option. 

Workspaces dialog box can also be opened by selecting the command Settings from the 

Menu and then, from the newly opened box, selecting the command Workspaces. 
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Pic. 12 – Workspaces dialog box 

Speakers volume 

To adjust the speaker volume, you need to left-click on the Master icon  , located in the 
right corner of the Panel. It will open a vertical and horizontal scroll bar. By moving the 
vertical scroll bar on the Panel or by moving the horizontal scroll bar in the upper right corner 
of the Desktop, you can change the speaker volume.   

    

Pic. 13 – Adjusting the speaker volume – vertical and horizontal scroll bar 

  



ITdesk.info – project of computer e-education with open access 

ITdesk.info is licensed under a Creative Commons Attribution-  

Noncommercial-No Derivative Works 3.0 Croatia License   12/57 

Date and Time 

To change the date and time, you need to right-click the Time icon , which is shown 
in the right corner of the Panel and then choose the command Properties from the quick 
menu. It will open a Date/time properties dialog box, that will allow you to change: 

 Layout – to determine what will appear first; date, then time; time and then date or 

just date or just time,  

 Format – to determine format in which Date and Time will be displayed, and   

 Font – size of Date and Time characters. 

 

Pic. 14 – Date and Time dialog box 

Desktop Background 

To change the Desktop Background, position on it and right-click and then choose the 
command Desktop Settings from the quick menu.  

In the Desktop dialog box, under the Background tab, you need to choose one of the images 

or, click on the Add an image to the list button . That will open Add Image File(s) dialog 
box, in which you need to find the image that has been stored on the computer and then click 

on the Add button  to add the image. 
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Pic. 14 – Desktop dialog box - Background tab  

It is possible to choose how you wish to display: 

 Single image – one image will be the desktop background  

 Image list – images from the list on which different images may be added 

 None – background will be empty 

Background can be adjusted by: 

 Brightness or  

 Saturation of the color – it will highlight the warm or cool tones. 

Exit the Desktop dialog box by clicking on the Close button  . 
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Screensaver 

To adjust the Screensaver, you need to choose the command Settings from the Menu and 
then choose the command Screensaver from the newly opened drop-down menu. 

 

Pic. 15 - Screensaver Preferences dialog box 

Screensaver Preferences dialog box will appear, in whose tab: 

 Display Modes, you need to choose one of the offered modes by pressing on the down 
arrow key, next to the Mode field.  
 

o Disable Screensaver 
o Black Screen Only 
o Only One Screen Saver 
o Random Screen Saver 

By dragging the slider down, below the screensaver list, and by choosing one of the 
offered screensavers, you can see the selected screensaver on the right side of the 
dialog box. This way, you can see more screensavers in a row. By pressing the Enter 
button on the keyboard, you open Preview, and pressing any other key on the 
keyboard or the mouse, you exit the Preview. 

You can also access Preview of the selected Screensaver by pressing on the Preview 
button, located on the right side of the dialog box, below the selected screensaver.  

You can set the time of inactivity, after which the Screensaver will automatically 
appear and the length of time to repeat the animation cycle.  
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 Advanced allows you:  
 

o Image Manipulation, or  
o Text Manipulation – enter the text that will be seen on the Screensaver, or  
o choose Display Power Management which allows, during the time of inactivity 

to: 
 put processes in Standby After specified number of minutes – processes 

are stopped and saved, active documents are not being closed and the 
computer goes to the minimum energy consumption state,  

 processes Suspend After specified number of minutes – processes are 
stopped and saved, active documents are not being closed and the 
computer shuts down, or  

 computer Off After specified number of minutes – processes are 
stopped, active documents are being closed and the computer shuts 
down.  

o adjust that by turning on and off the computer, screensavers’s colors gradually 
fade using Fading and Colormaps. 

Resolution 

Pixel (picture element) is a basic element from which the picture on the monitor display is 
based. A monitor that can display more dots is said to have a better, higher quality picture. 
Quality of the monitor picture is described as resolution. Seeing that the display is shaped 
rectangularly, resolution is expressed with two numbers: horizontal and vertical number of 
dots (i.e. 800 x 600). Monitor whose display can display the maximum of 800 x 600 dots, 
basically can display maximum of 480 000 dots, that is pixels. Today’s monitors are made in 
high resolution, for example up to 2 560 x 2 048 pixels.  

To adjust the resolution, you need to select the command Settings from the Menu and choose 
the command Monitor Settings from the newly opened menu. 

A dialog box Display will open, in which you need 
to click on the down arrow, next to the Resolution 
field and from a drop-down menu, using the left 
mouse button, choose the desired value. You can 
also choose screen Rotation or Reflection. The 
dialog box is closed by pressing on the Close 

button .  Besides the term of resolution, 
there is the term of the size of the monitor screen. 
Screen size is measured by the length of the 
monitor diagonal screen usually expressed in inchs 
(1 inch = 25, 4 mm). 

 

 

Pic. 16 – Dialog box Display 



ITdesk.info – project of computer e-education with open access 

ITdesk.info is licensed under a Creative Commons Attribution-  

Noncommercial-No Derivative Works 3.0 Croatia License   16/57 

Select and add keyboard language 

It is necessary to adjust the keyboard language so that all of the letters and signs which are 
displayed on the keyboard can also be displayed on the computer display. 

To change keyboard language, you need to choose the command Settings from the Menu and 
from the newly opened menu choose the command Keyboard. That will open a dialog box 

Keyboard in whose tab Layout you need to press the button Add . Dialog box 
Keyboard layout selection will open, in which you find the desired language. 

It is usually enough for only one language to be active so that all of the keyboard signs 
(especially č, ć, ž, y, z) can be seen. 

 

Pic. 17 – Keyboard dialog box 

 

Pic. 18 – Keyboard layout selection dialog box 
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If some of the selected languages is not installed, it is necessary to choose the command 

Settings from the Menu and then the command Language Support from the newly opened 

menu. A dialog box Language Support will open, by which the desired language will be 

installed. Pressing the button Install / Remove Languages will open Installed Languages 

dialog box, with a list of all the languages. Installed languages are marked with a tick on the 

right side of the dialog box. If the wanted language is not installed, you need to tick the square 

below the column Installed and press the button Apply Changes. That will automatically 

download the language from the internet. 

 

Pic. 19 – Language Support dialog box 

Program management 

Installing programs 

Not all programs are installed the same way. Some programs have the file with an extension 

.exe which launches the application, and some programs need to be installed via Terminal. To 

install something via terminal, it is necessary to know the commands that need to be entered 

so that the program can be installed after being downloaded. 

Removing programs 

Choose the command System from the Menu and then, from the newly opened menu, choose 
the command Install/Remove Software. A dialog box Synaptic Package Manager will open, 
along with the list of all programs, whether they’re installed or just recommended.  
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In the left pane, choose the display of Installed programs. In the right pane, find the program 
that you wish to remove. If you right-click on the desired program, a quick-menu will appear, 
from which you choose the command Mark for Removal.  

After all of the programs that you wish to remove have been selected, you need to press the 
button Apply, located in the main dialog box Synaptic Package Manager. 

 

Pic. 20 – Synaptic Package Manager dialog box 

Using a key on the keyboard – print screen 

The Print Screen or PrntScr key will open a dialog box Screenshot which enables you to 
capture the picture of: 

 Entire screen,  

 Active window, or  

 Select a region.  

You can also choose the option Delay before capturing or the option of capturing the mouse 
pointer Capture the mouse pointer when capturing the screenshot. Delaying the capture is 
mostly used when you wish to set the screen for capturing.  
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Pic. 21 - Screenshot dialog box– before and after capturing the screenshot 

After the screenshot has been captured, a dialog box Screenshot will open, by which the 

screenshot can be:  

 Save in a certain file – Save screenshot as... dialog box will open, by which you can 

choose the location for saving the screenshot, title and the type of the screenshot (for  

image files it is .png or .jpg), or 

 Copy to clipboard and then later Paste for example in the word processing program  

LibreOffice Writer, or 

 Open with  for example, a picture processing program  GIMP, or 

 send to Zimagez – free Online image hosting service. 

Screenshot dialog box can also be opened by choosing the command Accessories from the 

Menu and then the command Screenshot from the newly opened menu.  
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In case that the command Screenshot is launched, but the screenshot is unable to be saved, 

you need to delete the xfce4-screenshooter file, which is located in the Home Folder in the 

hidden files of the User. Hidden files can be shown, if you choose the command Hidden 

Folders from the View menu. That will display the hidden folders along with the user folders. 

You need to open the .config folder and find the .xfce4 folder, from which you need to delete 

the xfce4-screenshooter file. 

Home Folder → User → View and Hidden Folders → .config → .xfce4 → xfce4-screenshooter 

~/.config/xfce4/xfce4-screenshooter 
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1.3 ICONS 

Icons are small thumbnails on the computer display, which represent programs, folders, files. 

  or  Application shortcut icon LibreOffice Calc – program for                 
processing tabular data      

 or  Application shortcut icon LibreOffice Writer – word 
processing program 

   Application shortcut icon LibreOffice Impress – program for creating 
presentations 

   Icon New folder  

    Icon Home Folder – opens the folder manager 

  /  Icon Trash – icon for the empty / full  wastebasket 
 

Selecting, moving and opening icons  

Icons are selected by left-clicking the mouse on the icon.  

Group of icons can be selected in one of the following ways: 

 Press and hold the left mouse button on the empty place on the Desktop and drag the 

mouse pointer towards the group of icons, until the desired icons are selected and 

then release the mouse button.  

 

Pic. 22 – Selecting a group of icons 



ITdesk.info – project of computer e-education with open access 

ITdesk.info is licensed under a Creative Commons Attribution-  

Noncommercial-No Derivative Works 3.0 Croatia License   22/57 

 Selecting adjacent icons: First you need to select one icon and then press and hold  
Shift key and select the last icon in the row and then release the Shift key  

 Selecting nonadjacent icons: First you need to select one icon, press and hold Ctrl key 
and then select nonadjacent icons and release the Ctrl key  

Icons are moved by the Drag and drop method – you need to select an icon and hold the left 
mouse button until the mouse pointer has been dragged to the place where you wish to move 
the icons, after which you release the mouse button. 

Possible locations for moving icons are being shown while the icon is being moved. If you 
wish, you may position the icon in the provided field (square). 

 

Pic. 23 – Display of the moved icon and the field provided for the icon 

Icons are opened by: 

 double-clicking the left mouse button in the icon, or 

 selecting the icon and pressing Enter 

 

Working with shortcuts 

Shortcut is an icon recognizable by the tilted arrow sign  which is connected to the certain 
file, folder or a program. Shortcut is usually used for opening frequently used programs or 
files. 

Any program installed on the computer may be opened via Menu, where the desired program 
needs to be found and selected. However, if the certain program will be used frequently, it is 
practical to create a desktop shortcut to that program. That will enable quick opening of the 
program by double-clicking on the shortcut icon, without having to use the Menu. 

Shortcut can be opened by double-clicking the left mouse button on the icon.  

Creating the shortcuts is described in the chapter 2.2. 

Keyboard shortcuts  

To set the keyboard shortcuts, you need to choose the command Settings from the Menu and 

then, drom the newly opened menu, choose the command Keyboard. That will open the 

Keyboard dialog box, in whose tab Application Shortcuts you need to press the Add button. 
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Pic. 24 – Keyboard dialog box–Application Shortcuts tab 

 

Dialog box Shortcut Command will open – for you to choose a command for which you wish 

to create a shortcut. By pressing the Open button, dialog box Select command will open, in 

which you need to find the desired command and press the Open button. In the dialog box 

Shortcut Command, the selected command is affirmed by pressing the button OK.  

 

Pic. 25 – Dialog box Shortcut Command 

Then, dialog box Command Shortcut will open – used for selecting the shortcut that will open 

the command. You need to press the desired keyboard combination. When the keys are 

released, dialog box Command Shortcut will close.  
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The command with the assigned shortcut will appear in the list of commands in the dialog box 

Keyboard under the tab Application Shortcuts.  

 

Pic. 26 – Dialog box Command Shortcut 
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1.4 BASIC WINDOWS OPERATIONS 

It is possible to have multiple opened windows, and only one that is active: 
 

 active window has a highlighted frame, whilst the inactive one has a gray frame 

 opened window becomes active if you left-click on it 

 opened window also becomes active if you left-click on its thumbnail on the Panel 

Recognizing different parts of windows  

Basic window parts are: title bar, menu bar, toolbars, status bar and sliders. 

 

Pic. 27 – Window elements 
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Dialog box 

Dialog box is a specific type of window which opens after the use of certain tools and it offers 
a (?)choice of possibilities for completing a task. The choice you make is confirmed by pressing 

the button Close . Unlike the standard windows, their size is invariable. 

 

 

Manipulation buttons are located in the right corner of the window’s title bar: 

 Button for hiding the window behind the title bar – title bar stays at its home position 

 Button for lowering the window to Panel 

 Button for expanding the window over the Desktop 

 Button for closing a program and removing the window from the Desktop 

Moving windows 

Windows are moved by the Drag and Drop method, so that you press and hold the left mouse 

button on the title bar and drag the mouse pointer  to the place where you wish to move 
the window, and then you release the mouse button. 

It is necessary to position the mouse pointer in the window’s corner and, when the pointer 
changes its shape to , press and hold the left mouse button and, by using the Drag and Drop 
method, increase or decrease to the desired size.  

Switching between multiple opened windows 

Switching between multiple opened windows can be done by: 

 pressing the left mouse button within the desired inactive window – this way is 
possible only if the windows are at least partially visible on the Desktop 

Pic. 28 – Example of the dialog box 
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 pressing the left mouse button on the thumbnail of the desired window on the Panel – 
that causes the selected window to appear above all others and it is active 

 Alt + Tab keyboard shortcut, a dialog box with the preview of open windows appears. 
Hold the Alt key, and by pressing the Tab key, you will move between the opened 
windows. When you are positioned on the desired window, release the Alt key. 

 

Pic. 29 – Switching between opened windows – using the Alt + Tab keys 
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2 FILE MANAGEMENT 

2.1 BASIC TERMS 

File is a set of digital data recorded in the memory as a logical unit.Each file is characterized by 
its beginning, end, size and name. Due to a better visibility (convenience), files are placed in 
Folders. 

  

File start management 

In Linux Lite operating system, file management can be performed by:  

 Home Folder – a simple version of the file management application, or 

 File Manager –Thunar application for file management. 

Display of windows file manager can be adjusted via the menu of each menu. Window can be 

changed in:  

 Path 

 Side pane 

 

HOME FOLDER 

Launching the file manager via Home Folder can be done in several ways: 

 by clicking on the Home Folder thumbnail  on the Panel, 

 by launching the shortcut which is usually located on the Desktop or 

 via Menu by choosing the command Accessories and then, from the newly opened 
menu the Home Folder 
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Pic. 30 - Home Folder window – root 

In the file manager, the Home Folder has an icon  and it is named according to the 
username. In this case, the user is root, therefore that is the name of the folder. User files are:  

 Folder Desktop – used for displaying folders and files on the desktop. This folder can 
be opened by right-clicking on the Desktop and choosing the command Open in New 
Window from the newly opened menu. 

 Folder Documents – used for organizing and storing the documents (text files, 
workbooks, presentations…) 

 Folder Downloads – used for storing the documents and programs downloaded from 
the internet 

 Folder Music – used for organizing and storing music  

 Folder Pictures – used for organizing and storing pictures  

 Folder Public – used for storing documents and programs that are visible to other 
users in the network (i.e. in companies, computers are often connected to the local 
computer) 

 Folder Templates – used for organizing and storing templates 

 Folder Videos – used for organizing and storing video materials 

Creating a new folder in the folder Music: 
 

1. You need to open the Home Folder by clicking on ther icon Home Folder  on the 
Panel. 

2. In the dialog box file management, open the folder Music. 
3. Within the folder Music, press the keyboard combination Shift+Ctrl+N or, from File, 

choose the command Create New and then then Folder.  
4. In the dialog box Create New... you need to rename the folder and store files, subfiles, 

programs in it. Dialog box is closed by clicking on the OK button.  
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Pic. 31 – Dialog box Create New for entering a name for a folder 

 

FILE MANAGER 

File Manager can be launched in several ways:  

 by clicking on the thumbnail Open Folder with Thunar on the Panel, or 
 by launching the shortcut which is usually located on the computer Desktop. 

 

Pic. 32 File Manager  

If the thumbnail Open Folder with Thunar is not located on the Panel, Desktop or the Menu, 

you need to add it. 

The command is added to the Menu by choosing the command Settings from the Menu and 

then, from the newly opened menu, by choosing the command Main Menu. In the dialog box 

Main Menu, you need to find the command Open Folder with Thunar and left-click on the 

empty box next to the icon, to add it to the Menu. The dialog box is closed by pressing the 

button Close. 
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Navigation through the storage devices  

Working with folders and files using the Data Manager  

File Managers are used for a hierarchical preview of folders and files within the data manager 
device.  

   

Pic. 33 – Folder Manager window – File Manager and Home Folder 

Main parts of the File Manager window are:  

 Menu bar – preview of the available menus 

 Path bar – address of the location where the user is currently located. Each file/folder 
has its own Path – address of the location in which it is placed.  
 
In the File Manager, from the menu View, choose the command Location Selector and 
the desired preview of the toolbar: Pathbar Style or Toolbar Style. 

 

 

Pic. 34 –Address bar – Pathbar and Toolbar 

Next to the address bar, depending on the File Manager, there are buttons for: 

o previewing the user authorization level  (e.g. You are in super user mode)  

o opening the New Tab  

o moving between folders   

o returning to the Home Folder  
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 Side Pane – for previewing the main folders, available discs and USB connectors and 
user shortcuts. If you left-click on a folder, the content of the folder will be shown in 
on the right side of the window. 

 Main area – shows the content of folders, discs or USB connectors chosen from the 
Side Pane. Folders on the right side of the window are opened by left double-clicking. 

 

Pic. 35 File Manager – preview of the window details 

Creating shortcuts  

Shortcut to a folder located in the File Manager is created by pressing and holding the right 

mouse button on the folder and then choosing the Send To from the newly opened menu 

and:  

 Side Pane – within the dialog box File Manager, a link to the original folder will appear  

 Desktop -  a link to the original folder will appear on the desktop, 

 some other location for the shortcut Hard drive, Mail Recipent and so on. 
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Pic. 36 –Creating a shortcut 

If you, for example, wish to make a shortcut for the folder Music on the Desktop, you can also 

do it in the following way: 

1. press the right mouse button on the Desktop and from the quick-menu choose the 
command Open in New Window 

2. in the dialog box Desktop, from the Side Pane, choose the folder of the User and right-
click on the folder Music 

3. choose the command Send to from the quick-menu 
4. from the newly opened menu, choose Desktop (Create Link). 

 

Pic. 37 – Creating a link to the folder Music 
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Preview within the operating system of data storage device, folders, files in a 

hierarchical manner  

 each device owns a thumbnail and an assigned name 

 there can be one Hard Disk Drive, there can be more or one may be divided in multiple 
Partitions 

Devices which are used for data storage by the operating system are marked either by a 

default name (i.e. My Stick, Working Disc) or by the device capacity (i.e. 360 GB File System) 

and are available through the File Manager. The name of the connected device is changed by 

right-clicking on the device’s thumbnail and choosing the command Properties from the 

quick-menu. A dialog box Properties will open, in whose tab General, you enter the new 

Name. 

Data storage devices are: 

 Floppy disk 

 Hard Disk is a place for a permanent storage of data  

 Network drive –  disk connected to a local computer network 
 access: opening a File Manager and choosing Network from Side pane  

 USB stick  

 CD-RW (Compact Disk ReWritable)  

 DVD-RW (Digital Versatile Disc ReWritable) 

 

Unit measure of the size of files and folders: KB, MB, GB 

1 KB (kilobyte) - 1024 bytes (approximately 1000 bytes) 

1 MB (megabyte) - 1024 kilobytes (approximately a million bytes) 

1 GB (gigabyte) - 1024 megabytes (approximately a billion bytes or a thousand 
megabytes) 

Why make an extra copy on the portable storage devices  

Backups of files are recommended to be stored on one of the portable media, and thus 

ensure the original source of data, in case of losing or damaging. 

Advantages of storing data on network devices  

If the computer is connected to the computer network, you can access the shared data and 

devices, which are shared with other computers in the network. In the File Manager window, 

from the menu Go, choose the command Network. In the File manager window, there is a list 

of the network devices (i.e. printers) and the network to which the computer is connected.  
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Pic. 38 - File Manager - Network 

Storing data on network or on-line devices enables the accessibility of data to: 

 all users with the permission to access at the same time 

 users on distant locations 

 permanently store data  
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2.2 FILES AND FOLDERS 

Opening window to display folder properties  

After right-clicking on the folder, choose the command Properties from the quick-menu. In 
the open dialog box Properties, under the tab General, there are available information on the 
name and size of the folder.  

Adjusting the view on devices and folders  

Sometimes, when the window is not maximized, you cannot see all the information on the 
files and folders. That is when the vertical and/or horizontal sliders used for the complete 
window preview appear. Also, you can adjust the window size so that the whole height and / 
or length of the window is visible in a way that:  

 the mouse pointer needs to be positioned on the edge of the window that you wish to 
move  

 when the mouse pointer changes the shape to an arrow showing directions in which 
you can move the window edge, you need to use the Drag & drop method; press and 
hold the left mouse button, drag the window to the desired location and release the 
mouse button.  

Simultaneous changing of the height and width of the window is done in a way that you need 
to position the mouse pointer in any corner of the window and also use the Drag & drop 
method to determine the size of the window.  

Creating folders and subfolders  

Creating folders 

To create a folder on the Desktop, press the right mouse button and open the quick-menu, 
from which you choose the command Create Folder. In the dialog box Create New Folder, 
enter the name. By clicking on the button Create, you open a new folder.  

Creating subfolders  

Subfolders in the File Manager can be created by opening any folder (by left double-clicking 
on it) and: 

 from the File menu choose the command Create Folder, or 

 right double-click and from the quick-menu, choose the command Create Folder. 

Subfolder can be created in the Home Folder by:   

 choosing the command Create New from the menu File and then, choosing the 

command Folder from the newly opened menu,  
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 pressing the Shift+Ctrl+N keyboard combination, or 

 right double-clicking and choosing the command Create Folder from the quick-menu. 

 

 

2.3 WORKING WITH FILES  

A file is determined by name and extension. The extension indicates the file type (text, 
multimedia…), that is, it tells us by which application is the file made.  

File extensions of the frequently used files: 
.exe – executive 

.sys, .dll - system 

.tmp, .temp – temporary  

.rar, .zip, .7z – compressed  

.jpg, .jpeg, .gif, .png – image 

.mp3, .wav, .wma – audio  

.avi, .wmv, .mpg, .mp4 – video  

.txt – text i.e. Text Editor 

.rtf, .odt, .ott – LibreOffice Writer 

.ods, .ots – LibreOffice Calc  

.odp, .otp – LibreOffice Impress 

.odb – LibreOffice Base 

.pdf – (Portable Document Format) - Adobe Acrobat 

.htm, .html, .asp, .aspx, .php - web 
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Text Editor  

Text Editor is a simple text editor, with limited possibilities of text editing. Application Text 
Editor is launched via Menu. In Menu, you need to choose the command Accessories and, 
from the newly opened menu, the command Text Editor. 

Empty file Text Editor can be opened if you right-click the mouse button and choose the 
command Create From Template from the quick-menu, and then the command Empty File 
from the newly opened menu. 

 

Pic. 39 –Text Editor – main window parts 

When you wish to save the file for the first time, you need to choose the command Save As 
from the File menu. That will open the dialog box Save As, in which you enter the file name, 
within the field Name and the location where the file will be saved, using the field Save in 
folder. Dialog box Save As is also opened by pressing Shift+Ctrl+S keyboard combination. 

In case that the file has already been saved in a certain place and under a certain name, it is 
sufficient to simply click on the command Save, or use the Ctrl + S keyboard combination to 
save the changes. 
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Selecting File status  

File/folder needs to be selected and then you need to right-click and choose the command  
Properties from the quick-menu. In the open dialog box Properties, in the tab Permissions, 
you can assign the following file accesses: 

 Read and Write – it is possible to make all the changes over the original file.  

 Read Only – file can be opened and changed, but when you wish to save it – a dialog 
box Save As will open. The new file will be saved under a different name, and the 
original file will not be changed because it is available for reading only. 

 Write Only – every time an empty file opens and the content cannot be seen until the 
permissions are changed.  

 None – both reading and writing are not possible 

The selection is confirmed by clicking on the button Close. 

 

Pic. 40 – Dialog box of the folder Properties– tab Permissions 

If you wish to remove a selected option from a file/folder, you need to choose another option 
from the dialog box Properties. 
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Sorting the view of files in folders  

File preview in the File Manager 

From the toolbar in the View menu, you can choose the following commands: 

 Arrange Items and one of the ways to sort the files:  
 

o Sort by Name 
o Sort by Size 
o Sort by Type 
o Sort by Modification Date 
o Ascending – alphabetical list from A to Z 
o Descending – alphabetical list from Z to A 

 

Pic. 41 – File sorting 

 Zooming the size of the icons:  
 

o Zoom in 
o Zoom out 
o Normal Size  

 

 File preview via: 
 

o View as Icons – only the name of the file is displayed below the icon. The 
command can also be done by Ctrl+1 keyboard combination. 

o View as Detailed List) – file details are shown next to the icon (size, type, etc.) 
The command can also be done by Ctrl+2 keyboard combination. 

o View as Compact List – the title is shown with the icon. The command can also 
be done by Ctrl+3 keyboard combination. 
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Pic. 42 –View menu 

File preview in the Home Folder 

From the toolbar in the View menu, you can choose the following commands: 

 file preview:  
 

o Icon View – only the file name is shown below the icon  
o Thumbnail View of the icon – display of the zoomed in icons 
o Compact View – only the title is shown next to the icon 
o Detailed List – file details are shown next to the icon (size, type etc.) 

 

 Sort Files and one of the ways of sorting files; Ascending or Descending order: 
 

o By Name 
o By Modification Time 
o By Size 
o By File Type 

 

Pic. 43 – Sorting files 
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Good practice in naming files  

When naming files and folders, you should use meaningful names to indicate their content.  

Changing the name –  Renaming files and folders 

To rename a file/folder, you need to: 

 double-click on the file/folder thumbnail and choose the command Rename from the 
quick-menu, and then, enter the new name in the dialog box Rename, or 

 double-click on the file/folder thumbnail and choose the command Properties from 
the quick-menu and enter the name in the dialog box Properties, in the field Name, or 

 select file/folder, press F2 key and in the dialog box Rename File enter the new name. 
Dialog box will close by clicking on the OK button. 

2.4 OPERATIONS WITH FILES AND FOLDERS 

Selecting files and folders  

Files/folders are selected by positioning the mouse pointer on the folder and left-clicking. If 
you wish to select more than one file/folder: 

 press and hold left mouse button and drag the pointer until you have selected the 
desired group of files/folders 

 adjacent: after you have selected the first file, hold the Shift key and select the last file 
in a row. Then release the Shift key 

 non adjacent: hold the Ctrl key until you have selected all of the desired files/folder 
with the mouse 

 selecting all icons (files, folders, programs, shortcuts): Ctrl + A keyboard combination 
or, from the toolbar in the File menu, choose Select All Files 

 

Copying files and folders 

To copy files / folders, open the File manager and: 

1. in the Side Pane find folder from which you want to copy and in the right pane select 

the file/folder you want to copy, 

2. press the right mouse button and from the quick menu choose the command Copy, or 

use keyboard shortcut Ctrl + C, 

3. via Side Pane find and select the folder you want to copy the file or folder into, 

4. press the right mouse button and from the quick menu choose the command Paste, or 

use keyboard shortcut Ctrl + V. 
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Copying using the Drag and drop method: 

1. select the file/folder that you wish to copy 

2. press and hold the left mouse button on the selected file/folder and  then press and 

hold the Ctrl key 

3. drag the mouse pointer to the desired location 

4. release the mouse button and then the Ctrl key. Copy is pasted to the new location.  

Moving files and folders 

You can move files/folder in the File Manager by:  

1. finding and selecting a file/folder that you wish to move in the Side Pane  
2. holding the right mouse button and choosing the command Cut from the quick-menu  
3. positioning the mouse pointer in the location where you wish to move the file/folder, 

via the navigation pane 
4. pressing the right mouse button and choosing the command Paste from the quick-

menu 

Moving using the Drag & drop method is done in the same way as before, only without using 
the Ctrl key. 

By using the drag & drop method, files and folders will be permanently moved from the File 
manager. However, by using the drag & drop method, files and folders will also be copied in 
the File Manager.  

Deleting files and folders by sending them to Trash is done in one of the following ways: 

 via the File manager: find the file location in the Side pane and.in the right window, 
select the file or a folder that you wish to delete. From the menu Edit, choose the 
command Delete, or 

 via the mouse:  
o press the right mouse button on the file or folder and from the quick-menu 

choose the command Delete , or 
o using the Drag and drop method: hold the left mouse button on the file or 

folder that you wish to delete and drag it to the Trash 

 via the keyboard: select the file or folder and press the Delete key on the keyboard 

Restoring the deleted files and folders from the Trash 

Deleted files/folders which are located in the Trash may be restored to their original location 
on the computer. You need to select Trash from the Side Pane in the File manager. In the 
right side of the window, the trash content will appear. You need to find the file/folder that 
you wish to restore on its original location and press the right mouse button and choose the 
command Restore from the quick-menu. 
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Emptying the Trash 

To permanently delete the Trash, you need to, in the file manager: 
 

 choose the command Empty Trash from the File menu in the Side Pane 

 right-click on the Trash thumbnail and from the quick-menu choose the command 
Empty Trash. 

 

2.5 SEARCHING THE STORAGE DEVICES  

In order to search the storage devices, first you need to install a tool for searching data. 

Choose the command System from the Menu, and from the newly opened menu System, 

choose the command Install File & Folder Search. That will open a Terminal window, in which 

you will need to authorize the launching of installation by entering the password. 

 

Pic. 44 - LXTerminal 

The installation will carry out automatically. Once the installation is finished, you will be able 

to find the data searching tool Catfish in the Menu, under the menu Accessories. 
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Pic. 45 – Program Catfish 

In the empty field below the title Catfish, you need to enter the term you want to search. You 

can choose:  

 an option for searching the exact title; Exact match, within the Hidden files or Limit 

results to the default number of search results. 

 File type –Documents, Images, Music or Videos. 

 Folder that is searched 

 Search method – Find 

 

At the end, you need to click on the Find button. On the right side of the window, there will be 

all of the files and folders with the default name.  

 

Pic. 46 – Search example  
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Searching the data storage device using the wild cards: file types, first letter of the file 

If you cannot remember the name of the desired file, you can use the wild cards instead of the 

letters: star(*). If you enter the file extension of the file that you wish to find in the input field: 

 *.*txt   that will list all the files with the extension .txt 

 *.*bmp that will list all the files with the extension .bmp, itd. 

You can also search using the certain letters of the file name, such as:  

 *t.* that will list all the files which end with the letter t 
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3 UTILITIES 

3.1 WORKING WITH THE PROGRAM FOR COMPRESSING FILES 

Compressing reduces the space which the files occupy on the disc. Programs for compressing 
files are also used for joining a large numbers of files and folders in one compressed file. Some 
of the popular programs for compressing files are: 7zip, Zipeg, tar.gz etc. 

Adding files in a compressed folder 

To compress a file or a folder, you need to choose the menu Accessories from the Menu and 
then the Unzip/Compress Files program for compressing files. That will open a dialog box of 
the program for compressing files Xarchiver 0.5.2. 

 

Pic. 47 – Basic window of the program for compressing files 

Clicking on the thumbnail Open an archive  opens an existing archive using the dialog box 
Open an archive. 

Clicking on the thumbnail Create a new archive  opens a new archive using the dialog box 
Create a new archive. 
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Pic. 48 – Dialog box Create a new archive 

In the dialog box Create a new archive, you can determine: 

 Name of the archive,  

 via the Side pane where the archive will be stored:  
o Save in folder – if a folder in which you wish to save the archive exists, you 

need to find it, using the Side pane, or 
o Create folder – if the folder in which you wish to save the archive does not 

exist, you need to, using the Side pane, choose a place to save the new folder 
and click on the button Create Folder 

 Archive Type – extension that will be assigned to the archive (i.e. .zip, .rar etc.) 

Clicking on the button Create  opens a new empty archive.  

 
Pic. 49 – Archive thumbnail 
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In the window of the program for compressing file, which is now named as the default 

archive, you can, by clicking on the thumbnail Add files  open a dialog box Add files in 
whose tab Selection, you can find the files to add to the archive. In the tab Options, you can 

set the level of Compression and a Password. Clicking on the button Add will 
confirm your actions. 

You can also set the password in the dialog box of the program for compressing files via the 
menu Actions by choosing the command Enter password or Ctrl + R keyboard combination.  

Clicking on the manipulation button  you will exit the archive. 

 

Pic. 50 – Dialog box of the compressing window Xarchiver 0.5.2 

If you wish to add a new file or a folder to the compressed file, you need to open the archive 
by double left clicking or click on the command Open from the quick-menu. The content of the 

archive will be shown. Clicking on the thumbnail Add files  via the dialog box Add files, 
will find and add new files. 
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Unpacking a compressed folder 

 

Pic. 51 – Archive quick-menu 

To unpack a compressed folder, you need to right-click on the compressed folder thumbnail 

and choose the command Open from the quick-menu. 

That will open a dialog box of the program for compressing files named as the archive. You 

need to click on the Extract files button . That will open a new dialog box Extract files in 

which you determine:  

 

 Extract to file or folder from the archive,  

 Files that  are being extracted -  all or just some, and  

 additional Options: 

o Overwrite existing files, 
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o Freshen existing files, 

o Update existing files or  

o Password – enter the password if the file is being protected by a password.  

Dialog box Extract files can be opened if you choose the command Extract To from the quick-

menu. 

If you wish to extract files to a file with an archive, you need to choose the command Extract 

Here from the quick-menu.  
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3.2 VIRUSES AND ANTIVIRUS PROGRAMS 

A virus is a malicious program with the ability of auto replication. It searches for other files in 
the computer, trying to infect them, and its ultimate goal is spreading to other computers. 
Depending on the malicious code that it contains, it causes more or less damage to your 
computer. The virus spreads by transferring and opening the infected file (e-mail attachments, 
infected files on removable media, etc.). Even though viruses for computers running Linux are 
not so popular, it is recommended to install an antivirus program. Antivirus programs are 
used to find and remove malicious software. On the market there are a number of free 
antivirus programs intended for the Linux operating system. Some of them are: 

  Avast! – Linux Home Edition 

  BITDefender – Antivirus Scanner for Unices 

  Clam AntiVirus 

  AVG Antivirus Free – For Linux 

If, for example, you wish to examine (scan) device, folder or file with the help of anti-virus 

software ClamAV - it can be done by choosing the Terminal from the Panel and typing the 

command: 

 sudo apt-get install clamtk – command for installing ClamAV 

 sudo apt-get install clamav-freshclam – command for updating the program 

 clamscan – for scanning 

 freshclam – command for updating the program 

Antivirus program needs to be updated regularly, that is it is necessary to regularly download 
new virus definitions (the best thing is to set it to do so automatically while connecting to the 
internet). If you do not do that, antivirus program becomes useless because it cannot detect 
new types of malware.   

More on protection against viruses and other malicious programs can be found in the manual 

Basic Concepts of Information and Communication Technology, in chapter Protection while 

using ICT technology, published at the following link: 

http://www.itdesk.info/handbook_basic_ict_concepts.pdf . 

  

http://www.itdesk.info/handbook_basic_ict_concepts.pdf
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4 PRINTER AND PRINTING MANAGEMENT 

4.1 CHOOSING THE PRINTER FROM THE LIST OF INSTALLED PRINTERS 

If you have more than one printer, only one of them is a major one which automatically 
downloads all the print commands. You can change the default printer via the Menu. In the 
main menu, you need to select System and from the newly opened menu choose the 
command Printing. A dialog box Printing – localhost will open, containing the list of all 
printers on which the computer is connected. 

 

Pic. 52 – Dialog box Printing - localhost 

You need to select the desired printer and on the menu Printer choose the command Set As 
Default. A dialog box Set Default Printer will open, in which you set whether the default 
printer will be available to all user accounts on the computer Set as the system-wide default 
printer or just to the current user account Set as my personal default printer. 

 

Pic. 53 – Dialog box Set Default Printer 
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Installing/adding a new printer to the computer  

 Via Menu choose the command System and from the newly opened menu choose the 

command Printing. A dialog box Printing – localhost will open in which you need to 

click on the Add button . Find the desired printer from the newly opened menu 

New Printer, from the Network Printer and click on the button Forward  

and follow the instructions for adding printers. 

 

 

Pic. 54 – Dialog box  New Printer 

 Via the printer’s installation CD 

Printing the text document from a word processing application  

Choose the command Print from the File menu. Adjust the settings in the dialog box Print 

(number of copies, print specific pages, etc.) and press the button Print.  
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4.2 PRINT MANAGER PROGRAM 

If you wish to check what is currently being printed, you need to click on the icon  located 

on the right corner of Panel. A dialog box Document Print Status will open, showing current 

tasks that are sent to printing.  

 

Pic. 55 – Dialog box Document Print Status 

If you wish to stop the printing of a document immediately – you need to select the file that is 

waiting to be printed and click on the button Hold selected jobs  or right-click and open the 

quick-menu in which you need to choose the command Hold. To continue printing the 

stopped document, you need to choose the command Resume.  

If you wish to stop the printing of a document – you need to select the document and by 

right-clicking open the quick-menu in which you need to choose the command Cancel and 

click on the button Yes to confirm the selection. 

If you wish to print the document that is waiting to be printed on another printer – you need 

to select that document and by right-clicking open the quick-menu from which you choose the 

command Move To and, from the newly opened menu, choose on of the available printers.   
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This manual is intended for learning with the materials 

published on the following links: 

 

 

 

* Script:  

http://www.itdesk.info/Basic%20computer%20use%20notes.pdf 

 

 

* Video presentations which show the basic computer using and file managing:  

http://www.itdesk.info/en/using-the-computer-and-managing-files-1/ 

http://www.itdesk.info/en/using-the-computer-and-managing-files-2/ 

http://www.itdesk.info/en/using-the-computer-and-managing-files-3/ 

 

 

* Test exam: 

http://www.itdesk.info/sample%20exam/sample%20exam%20module%202.pdf 

  

* Video presentation which shows the solving of the test example: 

http://www.itdesk.info/en/exam-solution-module-2/ 

 

 

* Quizzes for users to solve on their own: 

http://www.itdesk.info/en/computer-managing-files-quiz/ 

http://www.itdesk.info/en/computer-managing-files-quiz/ 

 

  

http://www.itdesk.info/Basic%20computer%20use%20notes.pdf
http://www.itdesk.info/en/using-the-computer-and-managing-files-1/
http://www.itdesk.info/en/using-the-computer-and-managing-files-2/
http://www.itdesk.info/en/using-the-computer-and-managing-files-3/
http://www.itdesk.info/sample%20exam/sample%20exam%20module%202.pdf
http://www.itdesk.info/en/exam-solution-module-2/
http://www.itdesk.info/en/computer-managing-files-quiz/
http://www.itdesk.info/en/computer-managing-files-quiz/
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5 GENERAL TERMS OF USE 

Website www.ITdesk.info was launched by a non-governmental organization "Open 

Society for the Idea Exchange“ in order to actively promote human right for free 

access to information and human right to education.   

Feel free to copy and distribute this document, provided that you do not change 

anything in it! 

All freeware programs and services listed on the ITdesk Home Web site at ITdesk.info are the 
sole property of their respective authors. Microsoft, Windows, and Windowsxx are registered 
trademarks of Microsoft Corporation. Other registered trademarks used on the ITdesk Home 
Web site are the sole property of their respective owners. If you have questions about using 
or redistributing any program, please refer to: info@itdesk.info.   

These sites contain links to other web sites or resources. ITdesk.info team IS NOT responsible 
for the textual and/or advertising content or products that is provided on these 
sites/resources, as it is not responsible for any content that is available through them, nor the 
possibility of the inaccuracy of the content. Use links at your own risk. Also, ITdesk.info team 
does not guarantee:   
• that the content on this web site is free from errors or suitable for any purpose,   
• that these web sites or web services will function without error or interruption, 
• to be appropriate for your needs, 
• that implementing such content will not violate patents, copyrights, trademark or 

other rights of any third party.  

If you disagree with the general terms of use or if you are not satisfied with the sites we 
provide, stop using this web site and web services. ITdesk.info team is not responsible to you 
or any third party for any resulting damage, whether direct, indirect, incidental or 
consequential, associated with or resulting from your use, misuse of this web site or web 
services. Although your claim may be based on warranty, contract violation or any other legal 
footing, regardless of whether we are informed about the possibility of such damages, we 
shall be released from all liability. Accepting the limitations of our responsibilities is a 
necessary prerequisite for using these documents, web pages and web services 

All listed software in this or other documents published on ITdesk.info is stated only for 
educational or exemplary purposes and that we do not prefer, in any case or manner, this 
software over other, similar software not mentioned in materials. Any statement that would 
suggest that we prefer some software over other, mentioned or not mentioned in materials, 
will be considered a false statement. Our direct and unconditional support goes solely to open 
source software that allow users to become digitally literate without barriers, use computer 
and participate in the modern information society. 
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